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Task 

In this exercise you will learn how to modify a folding box from the library of resizable standards. 

You will do this by removing all closing elements on the top of the box and replacing them with a 

new type of closing system, and as a second step, you will complete the structure with new locking 

system. Both compound components you will take out from the Synergy Components library. 
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Exercise box: A50.45.01.01 Claw-Lock Closure Systems - Winged Flap Closure with 

Dustproof Flaps.evr. 

Library standard A50.45.01.01: Modified project: 

A (Length) = 90 mm  A (Length) = 140 mm 

B (Width) = 60 mm  B (Width) = 75 mm 

H (Height) = 150 mm H (Height) = 130 mm 

Location: 

 

 

 

Components 

(Location, 

Name) 

C:\EngViewWork7\Standards Library\mm\Standards\Folding Carton\ 

ECMA\A - Long Seam Rectangular\ 

A50.45.01.01 Claw-Lock Closure Systems - Winged Flap Closure with Dustproof 

Flaps.evr. 

1.Compound Components/Tops and Bottoms/Regular Tucks/ 01 Regular Tuck 

Lock 

2.Compound Components/Parts/Tongue Locking Systems/ 30 Tuck Tongue 

(Centered) 
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 2D structure of A50.45.01.01 
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2D structure of the modified design 
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Opening and Resizing the Standard A50.45.01.01 

1. Start the program. 

2. To begin opening the design, do any of the following: 

 On the File menu, click New. 

 In the toolbar, click the New Project . 

 

The Material dialog box appears. 

 

3. Click From Resizable Design. 

4. In Base type, select Folding Carton Cardboard, and then, in Name, select the material that you 

want to work with. 

5. To proceed, click Next. 

6. To locate the design, (1) navigate to the folder Standards (or at least to folder ECMA), (2) go in Flat 

Mode  and (3) in Search type the design's code: A50.45.01.01 (pictured). 

NOTE: Notice that the list of designs grows shorter with each new symbol you type. 
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7. After you have typed the design's ID, select the design in the list. 

 NOTE: Notice that the design is visualized in the preview zone in the right-hand area. 

  

8. To open the design, click Finish. 

 The design opens in its 3D view. 
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Preparing the Work Environment 

1. To switch to the 2D view, in the graphical area, click the 1up drawing tab (pictured). 

  

2. Resize the structure: In the Parameters tab, in the Expression column modifying the expressions 

of the main parameters: Make A=140; B=75; and H=130. 

NOTE: For each value, press ENTER after typing the value. This confirms it. 
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Deleting Components 

A resizable design is composed of different parts (components). 

 

We begin modifying the resizable design by removing the top components and replacing them with new 

compound components from the Synergy Components library. 

1. Select the top of the design. 

Consider the objects that you want to select, and then press the selection buttons on the toolbar. The 

options are: 

 Select with Intersect Selects all the objects that fall within the rectangle, either entirely or 

partially. 

 Select Outside Objects Selects all objects that are entirely outside the rectangle. 
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The two buttons can be used independently. This produces four selection scenarios: 

 Selects the objects that are inside the selection rectangle, either entirely or partially. Objects 

that are entirely outside the selection rectangle are not selected. 

 Selects the objects that are entirely inside the selection rectangle. 

 Selects the objects that are entirely outside the selection rectangle. Objects that are inside the 

rectangle, either entirely or partially, are not selected.  

 Selects the objects that are outside the selection rectangle, either entirely or partially. Objects 

that are entirely inside the rectangle are not selected. 

If we choose the first mode and select this way: 

 

we could miss some tiny elements: 
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That is why when an entire top or bottom are to be deleted, it's best if we use the second mode. 

 

2. To delete the selection, do any of the following: 
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 In the graphical area, right-click a blank area, and then click Delete on the context menu. 

 On the Edit menu, click Delete. 

 Press CTRL + DELETE. 

After the deletion, the drawing should look like this: 

 

3. In the Parameters tab, right-click, point to Groups, and then click Check All. 
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4. After all the parameters are listed in the table, right-click, and then click Delete Unused. 

 

The parameters that have no roles in the design have been deleted. 
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Attaching Synergy Compound Components to the Design's Structure 

The Synergy Components library is a collection of ready-to-use parametric components used in 

assembling a 2D structural design. 

1. Click the Synergy Components dropdown menu, and then click the Synergy Components folder. 

The subfolder structure appears. 

 

The library consists of three major groups of components: 
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Bases A base component is the foundation on 

which other components are attached to make up 

a resizable design. Each resizable design can 

have only one base, to which you attach single or 

compound components or whole parts of boxes. 

Compound Components A compound 

component is made up of one or several 

individual (single) components. It represents a 

ready part of a design — for example, top, 

bottom, whole locks. It has two or more active 

control points on which it is attached during the 

assembly of a resizable design. 

Individual Components A single component 

is part of the design attached to the base to 

assemble a resizable design or to create a 

compound component. The single component 

has two active control points. 

 

In our case we will attach a new top by using a compound component.  

The new compound component will be well calculated according to the length and the width of the box. 

When new values are entered for the length and the width, we will always have a well-recomputed 

design. This takes place because we use the Advanced Parameter Matching functionality. Before 

continuing, make sure you have functionality turned on --- On the Tools menu, click Options, and then 

click the Synergy tab. Then select the Advanced parameter matching check box. 

2. Navigate the path Compound Components | 01 Tops and Bottoms | 01 Regular Tucks. 

A list preview of the available components appears in the right-hand area. 
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NOTE: The preview area consists of two zones: a list zone, which contains the components in the 

current group, and a preview zone, which offers a view in detail of the currently selected component.  

Both the entire list view area and the preview zone can be expanded and reduced as needed 

(pictured). 

 

NOTE: You can change the size of the component icons – on the Tools menu, click Options, and then 

click Synergy. Then, in Image Width and Image Height, enter values that suit you. 

3. In the preview area, select the component 01 Regular Tuck Lock, and then begin dragging it into 

the graphical area. 
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NOTE: When you drag a component to the graphical area, four modes become available:   

 Vertical mirror (flips the component along the x-axis) 

 Horizontal mirror (flips the component along the y-axis) 

 Shows the dimensions set for the component 
 

 For a selected component, opens the component's parameters table. 

Sometimes, however, we need to mirror a component to be able to attach it correctly and create a valid 

design. In this case we use the Horizontal Mirror  or the Vertical Mirror  buttons. 
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4. Click Vertical Mirror    to mirror the component. 

 

5. Start attaching the mirrored compound component to the base from right to left. Position the first 

active point of the component on the first point of the base (pictured). 
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6. Position the second active point on the first folding line and click to attach the point. Position the 

rest of the active points in the same way, finishing in the left base corner: 
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After the last point of the component has been attached, the Component Parameters dialog opens 

automatically. The table represents the full list of the component’s parameters. 
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As we are working in the Advanced Parameter Matching mode, there are check boxes in front of the 

names of the dimensions. What does this mean? Let us take a look at the row displaying #Z. We can 

see that the distance named #Z will be linked to the parameter Z (displayed in the Design Name 

column), which will appear in the parameters list with the expression 7. As a result, this distance will 

become editable by changing the expression of the parameter Z. 
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NOTE: As we have #Z distances in both flaps, the parameter Z will control both flaps at the same time. 

Let’s pay attention to the distances #AX2 and# AX3 on the top of the list.  

During attachment of the compound component, the program extracts the distances between the clicks 

and send this data to #AX2 and #AX3. #AX2 adopts the distance between the second and the third 

clicks; #AX3 adopts the distance between the third and the fourth clicks.Thanks to the Advanced 

Parameter Matching functionality, the program detects that parameters exist that have these values 

and links #AX2 and #AX3 automatically with these existing parameters (A and B here) in the 

Expression column. 

IMPORTANT: The local parameters #AX2 and AX3 link the structure that we attach to the base. That is 

why it is critical that the expressions of these parameters must contain the parameters that control the 

design's main sizes – in this case these are the parameters A and B. In this way the attached bottom 

will be recomputed when the expressions of A and B change. 

By default, the two parameters are not selected, because they have been substituted by the existing 

parameters A and B. 



ENGVIEW PACKAGE & DISPLAY DESIGNER TUTORIAL — MODIFYING PARAMETERIC DESIGNS | PAGE 24 

Why are some rows with selected check boxes highlighted in blue? 

These rows are highlighted in blue, because the parameters (in the Design Name column), which will 

be linked to the component's dimension lines, are new for the drawing; they are not listed in the 

parameters list. Highlighting the parameters means that the parameters named THE, DFH, DFC, Z and 

others will be added to the Parameters tab list. In this way, the corresponding distances will be 

editable through these parameters. 

Also, the parameters in the compound component will go to the drawing's parameters list together with 

the dependences between parameters predefined in the compound component. For example, the 

parameter SLL depends on the parameter Z. 

 

Why some rows with selected check boxes are not highlighted? 

The black-highlighted rows mean that parameters that have these names already exist in the 

parameter list. This means that the expressions of these existing parameters will override the 

expressions of the parameters in the compound components. 

For example, the parameter PH=A/2 had existed in the drawing’s parameter list before we attached the 

new flap. (The parameter controls the flap's height in the box's bottom.) 
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But in the new compound component the parameter PH is linked to the height of the panel, and it 

needs to be AX3-1.5. If we leave things as they are, we would have one parameter that controls two 

different panels that have different functions. This must not be. That is why we will create a new 

parameter that will control the panel's height in the new top. 

5. Clear the check box in front of the #PH distance. 

The Design Name field is now empty and the formula preset for the compound component has 

appeared in the Expression field. 
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6. Click the Expression field, and then type PH1 in it, and then press ENTER. 

Note that no dialog box appeared for creating a new parameter. This means that a parameter named 

PH1 already exists. This means that we need to create a new parameter. 

7. To obtain the formula set originally in the compound component, select the check box in front of the 

#PH, and then clear it. Then in the Expression field type PH2, and then press ENTER. 

A dialog box appears for creating a new parameter. Note that in Expression, we see the formula 

originally set for the component. Which is what we need to have. 
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8. Click OK. 

We now have a parameter that controls the panel’s height in the new top. 

Let us pay attention to the other two parameters, UL and LSC, which are selected but not highlighted in 

blue. 

The parameter UL, when set to Yes, removes the crease line of the top panel relative to the crease line 

of the dust flaps; when set to No, it makes the two crease lines collinear.  

The parameter LSC sets the distance by which the crease line of the top panel is to be removed when 

UL is set to Yes. 

These two parameters are already in the parameter table because the bottom follows the same logic. 

As the parameters in the compound component in the top play the same role as those in the bottom, 

we can use the same parameters for both parts of the box – the bottom and the top. That is why we will 

not create any new parameters to control the top separately. 

9. Click OK. 

The rest of the parameters that were highlighted in blue have now gone into the parameter list. In this 

way we are now able to edit the top through the parameters in the parameter list. Moreover, we can 

use the same parameters to edit both flaps. For example, changing the height of the two flaps is done 

by changing the value of the parameter DFH. 
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10. To see the newly added parameters, click the Parameters tab. 

We will use the Trace Object Selection functionality, which highlights the parameters linked to a 

distance or a component that we point to in the graphical area. 

11. To turn on the functionality, in the tabular area, right-click and then check Trace object selection. 

 

12. In the graphical pane, select the dust flap. 
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13. Make Z=15. 

Both flaps have been modified, and the slit (parameter SLL) was recalculated automatically. 

Attaching a Tongue Locking System 

In addition to the top closing system, we can add locking elements. 

1. Navigate the path Synergy Components Tab | Synergy Components | Compound Components | 

Parts | Tongue Locking Systems. 

2. Select the 30 Tuck Tongue (Centered) component, and then drag it into the graphical area. 

3. Mirror the component vertically in order to prepare it for correct snapping towards the basic 

structure. 



ENGVIEW PACKAGE & DISPLAY DESIGNER TUTORIAL — MODIFYING PARAMETERIC DESIGNS | PAGE 30 

 

4. Start attaching the active points of the components from right to left on the base structure 

(pictured). We need to pay attention to which control points the new components are attached so 
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that they are correctly centered on the structure. 

 

After the last active point is attached, the Component Parameters dialog opens.  
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The highlighted rows indicate that all the parameters in the component are new for the project and will 

be included in the project’s parameter list after OK is clicked. 

5. Click OK. 
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NOTE: The new parameters came with the expressions set in the compound component. That is why 

the dependency between the tongue width (TTW) and that of the slit (CL) was transferred also in the 

project’s parameter list. 

6. Save the file. 
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